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Starting and Configuring Attendance Viewer 
 
Accessing the Attendance Viewer Application 
 

1. Login to the network using your login name and password. 
 
2. Double-click the Pinnacle Attendance Viewer icon in the Administrative Tools folder. 
 
3. Login to the attendance viewer using your network login name and password.  

Passwords are not reset each school year.  When you login at the beginning of the year, 
use the same password you used at the end of the previous school year. 

 

 
 

4. After successfully logging in, you should see the end date of the current Attendance 
Interval at the bottom of your screen.  Maximize the window for ease of use. 
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Changing your Password 
 

1. After successfully logging in for the first time, click on the Options menu and select 
Change your Password. 

 
2. Enter your OLD password and click OK.  

 

 
 
3. Enter your NEW password and click OK. The password requires a minimum of six 

characters and at least one number and letter. 
 

 
 
4. Re-enter your NEW password to make sure you did not make any mistakes and click 

OK. 
 

 
 
5. If your old password matches the database and both of your entries for your new 

password match, you will receive a message indicating your password was successfully 
changed.  Click OK. 
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Configuring Attendance Viewer 
 

1. Click on the Options menu and select System/Directory Settings. 
 

 
 

2. Change options as needed and click OK. 
• It is recommended to leave Automatically save data when a new student is 

selected checked.  With this option unchecked, you could inadvertently lose data. 
• List only INACTIVE students is used when you need to look up attendance 

information for withdrawn students. 
• The display options refer to what you will see in the grid.  Course Names will display 

the course descriptions for the student’s schedule.  Hour Descriptions will show the 
periods for the student’s schedule.  For purposes of writing this manual, the screen 
shots from the grid are taken with the display set to Course Names. 
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Entering and Editing Attendance 
 
Schoolwide Attendance Screen 
 

1. Click on the Edit menu and select Edit Schoolwide Attendance. 
2. Select the date to see attendance for.  Leave the code selection set to ALL. 
3. Click Get Data for [Date Selected].  [Date Selected] will be the date you selected to 

view in step 2. 
 

 
 

4. Select the student to edit.  Withdrawn students will be listed with an asterisk (*) in front 
of their name. 

5. Click Reset Attendance for Selected Students. 
6. Select the correct code and click OK.  The system will save the change and update your 

screen. 
 

Important note:  This screen may only be used to edit attendance data already recorded.  
You cannot add attendance data for students using this screen.  If you would like to see 
attendance history for the student, clicking the Grid button will open the grid with that 
student’s record.  See page 7 for more information on using the grid. 
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Student Finder/Editor (Grid) Screen 
 

1. Click on the Edit menu and select Student Finder/Editor (Grid). 
(TIP – Click the Magnifying Glass button on the toolbar) 

 
2. In the box next to the Select a Student box, begin typing the student’s name (last name, 

first name). 
 
3. Verify you have selected the correct student with the student id.  If the student does not 

match the one you need to edit attendance for, click on the drop down arrow in the 
Select a Student box and select the correct student. 

 

 
 

 

4. Click Get Student’s Schedule or press Enter.  This will retrieve the student’s schedule 
from the system and any attendance already recorded 

 
5. Using the mouse, click on the box in the grid that corresponds to the date and class the 

record will be modified for (Homeroom class for absences or Math class for tardies).  If 
you do not see previously entered attendance on the grid, click on Inactive Schedule to 
show classes the student has been moved out of. 
 
NOTE:  You may select multiple dates by holding the Ctrl key on your keyboard while 

clicking. When you have all of the selections made, click Attendance for 
SELECTED Items. 
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6. Click on the down arrow to display the list of attendance codes. 
 

 
 

7. Select the correct attendance code from the list. 
 
8. Enter a comment if desired.  Click OK. 
 

NOTE: Comments do not post to TEAMS but will print on the Attendance for Students 
report and are also available when you retrieve a student’s absence history. 

 
9. Click Submit to send the information to the database.  If you forget to click Submit 

before selecting the next student, the changes you made will automatically be posted if 
you have the option turned on to automatically save data.  See page 5 for more 
information. 

 
10. If the data is correctly received, you will see the following prompt.  Click OK. 

 

 
 

11. Repeat steps 2 through 10 to enter additional attendance information. 
 
12. Click Close. 
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Additional Information Available in the Grid 
 
Course Information 
 
To see additional information on a student’s schedule, click on the course description (or period 
if you have chosen to display hour descriptions).  You will see the following information. 
 

 
 
 
Attendance For One Student by Hour Report 
 
With a student selected on the grid, clicking on the Print button will generate the Attendance 
For One Student by Hour report for the entire school year.  If the Print button is grayed out, 
the student does not have any attendance history for the year to print. 
 
If you need to run this report for a shorter period of time than the whole year, detailed 
instructions are available on page 17. 
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Attendance Transaction History 
 
To see the history of a particular attendance record, right-click on the box in the grid, which 
corresponds to the date and class, you wish to review.  You will see all of the transaction history 
for that record. 
 

• Date Received indicates the actual date and time this attendance record was received 
by Pinnacle. 

• Deleted is a system flag that can be ignored. 
• AttCode is the attendance code for the record. 
• Comment is the comment you would enter when changing attendance in the grid. 

 

 
 
Moving the bottom scroll bar to the right displays more of the attendance history. 
 

• UserID indicates the person who entered the attendance record. 
• From shows how and/or from what source the attendance was entered. 
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Attendance for Inactive (Withdrawn) Students 
 
Adding 
 

1. Click on the Options menu and select System/Directory Settings. 
2. Check the option for List only INACTIVE students.  Do not change any other options on 

this screen. 
 

 
 

3. Click OK. 
4. Use the grid to add attendance as needed.  Refer to page 7. 
5. Click on the Options menu and select System/Directory Settings. 
6. Uncheck the option for List only INACTIVE students.  Do not change any other options 

on this screen. 
7. Click OK. 

 

Changing/Deleting 
 

The procedures for changing or deleting attendance for inactive (withdrawn) students are 
identical to using the Edit Schoolwide Attendance screen.  The only difference is that inactive 
students will be listed with an asterisk (*) next to their name.  Refer to page 6 for instructions. 
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District Attendance Codes 
 

Code Description Excused/Unexcused 
ACR Required Court Appearance Excused 
ADN Official Doctor Note Excused 
AEA Excused Absence Excused 
AFT Field Trip with PISD Staff Excused 
AHB Student Records use ONLY Excused 
AIS In-School Suspension Excused 
AMC Medicaid-eligible (EPSDT Program) Excused 
ARH Religious Holiday Note Required Excused 
ASU Out-of-School Suspension Excused 
AUA Unexcused Absence Unexcused 
AXX Data Entry Error Excused 
T Tardy Unexcused 
TXX Data Entry Error Excused 
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Printing Reports 
 
Attendance Tracking 
 
The Attendance Tracking report shows whether or not teachers have taken attendance. 
 

1. Click on the Reports menu and select Attendance Tracking. 
2. Select whether you want to see a list of teachers who did report attendance or a list of 

teachers who did not report attendance. 
 

• Attendance Reported On [Date] – This shows who reported attendance for the 
selected date on that date. 

• Attendance Reported For [Date] – This option shows who reported attendance for the 
selected date anytime. 

• Attendance Never Reported For [Date] – This option shows who has never reported 
attendance for the selected date. 

• No Attendance Reported On [Date] – This option shows who has not reported 
attendance for the selected date on that date. 

 

3. Select the date to run the report for.  By default, Today will be selected. 
4. Select 2nd Hour.  Teachers are not responsible for reporting anything in any classes 

other than 2nd Hour. 
5. Click Get the Data. The list of teachers you selected will appear in the box above. 
6. Click Print to send the report to the printer. 
7. Click Close when finished. 
 

 
 
Optional Criteria 
 
You may specify the date and time range to run the report for.  For example, if you wish to see 
who reported attendance before 8:50 AM today, enter 8:50 AM for the “Before” time and enter 
today’s date.  Use the Select an End Date button to enter the date in the correct format. 
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Attendance List (Truancy Report) 
 
The Attendance List report allows you to print a list of students that meet or exceed certain 
thresholds for attendance.  This report is useful in identifying students who may be reaching 
attendance limits and require a conference before going to truancy court. 
 

1. Click on the Reports menu and select Attendance List. 
2. In the Drop-down box, select whether you want to see students with Exactly n attendance 

entries, Less than n attendance entries, Less than or equal to n attendance entries, 
Greater than n attendance entries or Greater than or equal to n attendance entries (n is 
the number of attendance entries). 

3. Enter the number of attendance entries to search for. 
4. Click Select a range of dates to enter the date range to search for. To search only today, 

check the box for today’s date.  Click Use All Dates to search the entire school year. 
 

 
 

5. Select the attendance code to search for. 
6. Select the hours to search.  The default selection is All Day.  Change this selection to 1st 

Hour to run the report for Tardies or 2nd Hour to run the report for Absences. 
7. Select whether you want the list in alphabetical order by name or ordered by ID number. 
8. Click Get the Student List. 

 

The example below shows that we are looking for students with three or more unexcused 
absences.   
 

 
 

9. In the report window, click on the printer icon to send the report to the printer. 
10. Close the report window. 
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Detailed Attendance/Tardy Report 
 
The Detailed Attendance/Tardy Report provides a 25-day view of students’ attendance history 
for the entire campus.  This report is useful in identifying patterns of absences. 
 

1. Click on the Reports menu and select Detailed Attendance/Tardy Report. 
2. Click Select a New Range of Dates and enter the date range to search for.  To search 

only today, check the box for today’s date (this would be useful in printing a record of 
today’s attendance).  Clicking Use All Dates will only select the first 25 days of school. 

 

 
 

3. Select the options desired for this report. 
• Never select Include all students… as this will create a very lengthy report. 
• Count Absences to select students with absences and display their respective codes. 
• Count Tardies to select students with tardies and display their respective codes. 
• Using Count Absences and Count Tardies together will combine all attendance 

information on a single report. 
• You may leave the hour selection set to All Day. 
• Select whether you want the list sorted by Student Name or Student ID. 
• Leave All Students selected. 

 

 
 

4. Click Get A Detailed Report. 
5. In the report window, click on the printer icon to send the report to the printer. 
6. Close the report window. 
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Substitute Roster Report 
 
The Substitute Roster Report is used to print a roster of students for the substitute to manually 
record absences on.  This report is ideal for use since it does require a signature of the 
substitute. 
 

1. Click on the Reports menu and select Substitute Roster Report. 
2. Select the teacher(s) who have substitutes for the day. 

 

 
 

3. Click Get Report. 
 

 
 

4. Click the Printer icon. 
5. Select All or enter the page range to print and click OK. 
6. Close the Crystal Report window. 
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Attendance For Students 
 
The Attendance For Students report prints a history of a student’s attendance records within the 
date range specified.  This report is especially useful since it includes comments entered with 
attendance codes. 
 

1. Click on the Reports menu and select Attendance For Students. 
2. Select the student in the drop-down box for the report. 
3. Click (Optional) Select Date Range and enter the date range to search for.  To search 

only today, check the box for today’s date.  To search the entire school year, click Use All 
Dates. 

4. Click Get Student Data. 
5. In the report window, click on the printer icon to send the report to the printer. 
6. Close the report window. 

 
Attendance For One Student by Hour 
 
The Attendance For One Student by Hour report prints a history of a student’s attendance 
record within the date range specified.  This report also includes the student’s schedule and a 
summary at the end. 
 

1. Click on the Reports menu and select Attendance For One Student by Hour. 
2. Select the student in the drop-down box for the report. 
3. Click (Optional) Select Date Range and enter the date range to search for.  To search 

only today, check the box for today’s date.  To search the entire school year, click Use All 
Dates. 

 

 
 

4. Click Get Student’s Data. 
5. In the report window, click on the printer icon to send the report to the printer. 
6. Close the report window. 
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Schoolwide Attendance by Hour 
 
The Schoolwide Attendance by Hour report provides a detailed list of students marked absent or 
tardy for a selected day along with the appropriate absence or tardy code. 
 

1. Click on the Reports menu and select Schoolwide Attendance by Hour. 
2. Select the date to run the report for. 
3. Select whether you want the list sorted by Name or by ID. 
4. Leave All Students selected. 
5. Click Get Data for YYYY-MM-DD (where YYYY-MM-DD is the date you selected). 

 

 
 

6. In the report window, click on the printer icon to send the report to the printer. 
7. Close the report window. 

 
Attendance For an Inactive Student 
 
The Attendance For an Inactive Student report shows attendance records for inactive or 
withdrawn students. 
 

1. Click on the Reports menu and select Attendance For an Inactive Student 
2. Select the student in the drop-down box for the report. 
3. Click (Optional) Select Date Range and enter the date range to search for.  To search 

only today, check the box for today’s date.  To search the entire school year, click Use 
All Dates. 

4. Click Get Student’s Data. 
5. In the report window, click on the printer icon to send the report to the printer. 
6. Close the report window. 
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Student Demographic Data 
 
The Student Demographic Data report allows you to view Student Demographic information 
without having to log into to TEAMS.  Teachers also have access to this information in the 
gradebook by simply double-clicking on the student’s name. 
 

1. Click on the Reports menu and select Student’s Demographic Report. 
 

 

 
 
 

2. Click on the student you wish to see and click Get the Report. 
3. In the report window, click on the printer icon to send the report to the printer. 
4. Close the report window. 
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Printing Crystal Reports 
 
Students with Schedule Problems 
 
The Students with Schedule Problems report will identify students who have schedule problems.  
These problems will affect accurate attendance reporting and grade reporting for report cards if 
they are not corrected. 
 

1. Click on the File menu and select Print a Crystal Report. 
2. Select Students with Schedule Problems. 
3. In the report window, click the printer icon to send the report to the printer. 
4. Close the report window. 
5. Make copies of this report for each homeroom teacher affected and let them know to 

correct the problem. 
 
Elementary Attendance Summary for 6-Weeks Attendance Validations 
 
The Elementary Attendance Summary is used for validating attendance received in TEAMS 
against the attendance recorded in Pinnacle.  Compare this report to the TEAMS Student 
Attendance Detail – All Students report that you will print to your printer. 
 

1. Click on the File menu and select Print a Crystal Report. 
2. Select Elementary Attendance Summary from the report list. 
3. Click Get the Report. 
4. Enter the start date for the report.  This will typically be the first day of the Six Weeks you 

are validating for.  If you have other needs for this summary information, you may enter 
any date to start.  Enter the date in YYYY,MM,DD format.  Other formats will cause errors 
when running the report. 

 

 
 

5. Click OK. 
6. Enter the ending date for the report.  This will typically be the last day of the Six Weeks 

you are validating for.  If you have other needs for this summary information, you may 
enter any date to end.  Enter the date in YYYY,MM,DD format.  Other formats will cause 
errors when running the report. 

7. Click OK. 
8. In the report window, click the printer icon to send the report to the printer. 
9. Close the report window. 
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Pull Down Menus 
 

FILE 
 
Menu Item 

 
Description 

Print a Crystal 
Report… 

Opens the report list of available Crystal Reports. 

Exit Exits the Attendance Viewer and posts all changes to the teacher’s 
class files. 

 

EDIT 
 
Menu Item 

 
Description 

Edit Schoolwide 
Attendance 

Provides a screen to change previously entered attendance records for 
active and inactive students.  This screen does not allow entry of new 
attendance records. 

Edit Attendance for 
One Student by 
Hour 

Provides a screen to enter attendance for a single student.  This screen 
does not show previously entered attendance.  It is strongly 
recommended to avoid use of this screen for this reason. 

Edit Attendance for 
One Student by 
Schedule 

Provides a screen to enter attendance for a single student.  This screen 
does not show previously entered attendance.  It is strongly 
recommended to avoid use of this screen for this reason. 

Edit Attendance for 
Students by Hour 

Provides a screen to enter attendance for multiple students by name.  
This screen does not show previously entered attendance.  It is 
strongly recommended to avoid use of this screen for this reason. 

Edit Attendance for 
Students by ID 

Provides a screen to enter attendance for multiple students by ID 
number.  This screen does not show previously entered attendance.  It 
is strongly recommended to avoid use of this screen for this 
reason. 

Student 
Finder/Editor (Grid) 

Opens the grid for making attendance entries and changes.  This 
screen shows attendance history and is preferred for use in entering 
attendance and modifying attendance records. 

Edit Attendance for 
a Group 

Opens a window for entering attendance for a large group of students.  
This item has no practical use at the elementary level. 

Edit/Create/Delete 
a Group of 
Students 

Opens a window for creating and editing groups of students.  This item 
has no practical use at the elementary level. 

Edit/Create/Delete 
Dynamic Group of 
Students 

Opens a window for creating and editing a group of students that 
changes dynamically.  This item has no practical use at the elementary 
level. 

Edit Attendance for 
One Class 

This option allows entry of class attendance for a substitute.  Use of 
this option needs to be done in conjunction with the Substitute Roster 
Report. 

Clear Attendance 
for Re-entry by 
Gradebook 

Erases an item entered by the attendance clerk and resets the system 
to allow teacher entry for that date and student.  This item must not 
be used due to TEA regulations. 

Copy Attendance 
to Later Hours 

Allows duplication of an attendance code from one hour to other hours 
in the day.  This item must not be used since elementary reports 
daily attendance. 
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REPORTS 
 
Menu Item 

 
Description 

Total Present This report provides the number of students in your school on a 
selected date and the number of absence incidents reported. 

Attendance 
Tracking 

This report indicates whether or not teachers have taken attendance. 

Attendance List 

This report allows you to list students that meet or exceed certain 
thresholds for attendance.  This report is useful in identifying students 
who may be reaching attendance limits and require a conference 
before going to truancy court. 

Detailed 
Attendance/Tardy 
Report 

This report provides a 25-day view of students’ attendance history for 
the entire campus.  This report is useful in identifying patterns of 
absences. 

Students Who 
Skipped Classes 

This report provides a list of students who may have skipped class for a 
selected date, based on their attendance status for a specific hour.  
This report does not have any practical use at the elementary level. 

Substitute Roster 
Report 

This report provides a printed roster for substitutes to record 
attendance. 

Schedule for One 
Student 

This report shows the schedule for a student.  This report does not 
have any practical use at the elementary level. 

Student 
Demographic 
Report 

This option generates a report showing student demographic data. 

Attendance For 
Students 

This report prints a history of a student’s attendance record within the 
date range specified.  This report is especially useful since it includes 
comments entered with attendance codes. 

Attendance For 
One Student by 
Hour 

This report prints a history of a student’s attendance record within the 
date range specified.  This report also includes the student’s schedule 
and a summary at the end. 

Schoolwide 
Attendance by 
Hour 

This report provides a detailed list of students marked absent or tardy 
for a selected day along with the appropriate absence or tardy code. 

Attendance Counts 
by Type For All 
Hours 

This report displays the count of each attendance type used on a 
specific day, by period of the day, and with an explanation of the 
attendance codes.  This report does not have any practical use at the 
elementary level. 

Detailed 
Attendance Counts 
For One Hour 

This report displays the attendance counts for each attendance code 
for each hour on a specific day.  This report does not have any practical 
use at the elementary level. 

Attendance For an 
Inactive Student 

This report shows attendance records for inactive or withdrawn 
students. 

Attendance 
Outside Add/Drop 
Dates 

This report is designed to generate a list of students who have 
attendance entries outside of the dates for which the student was 
enrolled or withdrawn. 
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UTILITIES 
 
Menu Item 

 
Description 

Statistics/Graphs This allows you to print a pie or bar graph showing the corresponding 
counts of each attendance code for one date or a range of dates. 

Refresh Students, 
Dates, Codes 

This generates a new set of files and downloads them to your 
computer.  This is useful when the list of students, dates or attendance 
codes is incomplete. 

Post Updates to 
Gradebook 

Manual option for posting your changes to the teacher’s gradebooks 
during the school day.  This function runs automatically at the end of 
the day when you close the Attendance Viewer. 

Re-Submit ALL 
Attendance to 
Gradebook 

This option forces ALL attendance records within a specific date range 
to be posted back to the teacher’s gradebooks.  This option is NOT 
recommended and should be avoided as it will create extra wait 
time for the teachers when they open their gradebooks. 

Add a List of Dates 
This option is only available to system administrators.  If you need 
dates added to the system that do not already exist for make-up school 
days, please contact Jim Powers or Dana Adams. 

Maintain the Date 
List 

This option is only available to system administrators.  If you need to 
make changes to the date list, please contact Jim Powers or Dana 
Adams. 

Edit Attendance 
Codes 

This option is only available to system administrators.  If you need 
changes made to your attendance codes, please contact Jim Powers or 
Dana Adams. 

Re-order 
Attendance Codes 

This option is only available to system administrators.  If you need 
changes made to the order of your attendance codes, please contact 
Jim Powers or Dana Adams. 

Re-order Hour 
Codes 

This option is only available to system administrators.  If you need 
changes made to the order of your hours, please contact Jim Powers or 
Dana Adams. 

Locking 
Attendance Days 

This option allows you to lock or unlock all attendance from being 
entered on a certain date(s).  Please contact Jim Powers or Dana 
Adams if you are considering using this option. 

Print Attendance 
Letters 

This option is not used in PISD.  Please contact Student Records to 
request official Attendance Letters. 

Get PDA Password 
For Today 

This option is used to get a temporary password for a substitute to 
access the gradebook to record attendance.  This option is not used in 
PISD. 

See Student’s 
Demographic Data 

This option generates a report showing student demographic data. 
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OPTIONS 
 
Menu Item 

 
Description 

System/Directory 
Settings 

This option allows you to make system changes.  Refer to page 5 for 
more information. 

Log In to the 
Server 

If you are logged out, this option provides the login dialogue. 

Log Out from the 
Server 

If you are logged in, this option logs you out from the server. 

Change your 
Password 

This option allows you to change your password.  Refer to page 4 for 
more information. 

Select Attendance 
Interval 

This option allows you to change the semester you are currently 
working in.  This function does not have any practical use at the 
elementary level. 

Toolbar This option allows you to change the size of the button bar or remove it 
altogether. 

Status Bar This option turns the status bar on or off.  The status bar provides 
menu item information at the bottom of the main screen. 

 
WINDOW 
 
Menu Item 

 
Description 

Cascade This option arranges multiple windows so all titles are visible. 
Arrange icons This option is reserved for future use. 

 
HELP 
 
Menu Item 

 
Description 

Help This option opens Excelsior Software’s help file. 
About Attendance 
Viewer 

This option shows version and system information. 
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Special Notes 
 

 When clearing attendance, you must set the attendance code to AXX to clear absences and 
TXX to clear tardies for the student. 

 DO NOT make changes to attendance records directly in TEAMS.  It is important that both 
Pinnacle and TEAMS contain the same records. 

 If you are having difficulties entering attendance into Pinnacle or records appear to not be 
transferring to TEAMS, please call Jim Powers at x25981 or Dana Adams at x25976 for 
assistance. 

 History reports should always come from TEAMS.  Daily reports for today must come from 
Pinnacle. 

 TEAMS data will always be one hour behind.  Pinnacle records post to TEAMS at the top of 
every hour after they are entered. 


